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บทคัดย่อ 

  ข้าวโพดเลี้ยงสัตว์มีความส าคัญอย่างมากต่ออุตสาหกรรมการเลี้ยงสัตว์ความต้องการใช้

ข้าวโพดเลี้ยงสัตว์ในประเทศมีแนวโน้มเพิ่มสูงขึ้นมาก ปัจจุบันการผลิตข้าวโพดเลี้ยงสัตว์มีไม่เพียงพอต่อความ

ต้องการใช้ภายในและมีปริมาณไม่แน่นอนเนื่องจากการผลิตขึ้นกับดินฟ้าอากาศท าให้มีความเสี่ยงต่อความ

เสียหายจากความแห้งแล้งมากและพื้นที่ปลูกต้องแข่งขันกับพืชเศรษฐกิจอื่นที่ให้ผลตอบแทนที่ดีกว่า  จึงได้

ท าการศึกษาเกี่ยวกับการติดตามการเพาะปลูกข้าวโพดเลี้ยงสัตว์ในพื้นที่อ าเภอแม่พริก จังหวัดล าปาง 

 อ าเภอแม่พริก จังหวัดล าปาง เกษตรกรส่วนใหญ่จะเพาะปลูกข้าวโพดเลี้ยงสัตว์การศึกษาครั้งนี้ได้

ท าการศึกษาการจ าแนกพื้นที่เพาะปลูกข้าวโพดเลี้ยงสัตว์โดยใช้ดัชนีพืชพรรณ (NDVI) และ ดัชนีสิ่งปลูกสร้าง 

(NDBI) ในการจ าแนกและเปรียบเทียบหาความถูกต้องของเทคนิคทั้ง 2 ว่ามีประสิทธิภาพ แตกต่างกันหรือไม่

ตามช่วงระยะเวลาการเจริญเติบโต แบ่งเป็น 3 ช่วงคือ เริ่มเพาะปลูก ,เจริญเติบโต,เก็บเกี่ยว เพื่อน ามา

เปรียบเทียบค่าทางสถิติ
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ABSTRACT 

  Animal houses are very important to the animal husbandry industry, the 

demand for domestic animal houses has increased considerably, the production of animal 

houses is insufficient to meet the demand and the volume is uncertain due to the production. 

With the soil, the weather causes heat to heat from the very quiet and risks having to compete 

with other economic crops that yield better returns than usual. Study on the plant cultivation 

in Mae Phrik District, Lampang Province. 

 

 Mae Prik District, Lampang Province, most farmers cultivate maize for animal 

husbandry. This study was conducted to study the classification of maize acreage areas using 

the Vegetation Index (NDVI) and the Building Index (NDBI) for classification and comparison. It 

was correct that both techniques were effective.  Different or not according to the growing 

period, divided into 3  phases:  start planting, growing, harvesting.  To compare the statistical 

value
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บทที ่1 

บทน า 

1.1 ที่มาและความส าคญัของปญัหา 

ข้าวโพดเลี้ยงสัตว์นับว่าเป็นพืชไร่ชนิดหนึ่งที่มีความส าคัญต่ออุตสาหกรรมการเลี้ยงสัตว์เป็นอย่างมาก

ความต้องการใช้ข้าวโพดเลี้ยงสัตว์ในประเทศมีแนวโน้มเพิ่มสูงขึ้นมากหลังจากที่มีการขยายการเลี้ยงสัตว์

ตั้งแต่ปี 2535 ปัจจุบันการผลิตข้าวโพดเลี้ยงสัตว์มีไม่เพียงพอต่อความต้องการใช้ภายใน และมีปริมาณไม่

แน่นอนเนื่องจากการผลิตขึ้นกับดินฟ้าอากาศท าให้มีความเสี่ยงต่อความเสียหายจากความแห้งแล้งมาก

และพื้นที่ปลูกต้องแข่งขันกับพืชเศรษฐกิจอื่นที่ให้ผลตอบแทนที่ดีกว่าในระยะ 4-5 ปี ภาครัฐได้ด าเนินการ

แก้ไขปัญหาโดยจัดท าโครงการส่งเสริมการปลูกข้าวโพด เลี้ยงสัตว์ฤดูแล้งหลังนาเพื่อส่งเสริมเกษตรกรให้มี

การปลูกข้าวโพดเลี้ยงสัตว์ให้ถูกต้องตามหลัก วิชาการ ลดพื้นที่ปลูกข้าวโพดเลี้ยงสัตว์ในพื้นที่ไม่ถูกต้อง 

และเพิ่มพื้นที่ปลูกในพื้นที่ปลูกหลังนาฤดูแล้ง ที่เหมาะสมกับการปลูกข้าวโพดเลี้ยงสัตว์ เพื่อให้มีผลผลิตที่

เพียงพอกับความต้องการของตลาด 

เนื่องจากอ าเภอแม่พริกจังหวัดล าปางมีการเพาะปลูกข้าวโพดเลี้ยงสัตว์เป็นจ านวนมาก เป็นพืชที่นิยม
ในการเพาะปลูกของชาวเกษตรกรของอ าเภอแม่พริกโดยผู้วิจัยได้เห็นถึงความส าคัญของผลผลิตของ
ข้าวโพดเลี้ยงสัตว์จึงท าการศึกษาเกี่ยวกับการใช้เทคนิค NDVI และ NDBI ว่าเทคนิคไหนมีความแม่นย า
และมีศักยภาพในการผลิตข้าวโพดเลี้ยงสัตว์มากกว่าและแตกต่างกันหรือไม่ โดยใช้ภาพถ่ายดาวเทียม 
Sentinel-2 มาใช้เพื่อเป็นเครื่องมือใน การประเมินพื้นที่เพาะปลูกติดตามและใช้วิธีการทางสถิติในการ
เปรียบเทียบผลผลิตที่ไดจ้ากอ าเภอแม่พริก จังหวัดล าปาง  

 

1.2 วัตถุประสงคข์องการวิจัย 

1. การประยุกต์ใช้เทคนิค NDVI กับ NDBI ในการติดตามการปลกูข้าวโพดเลี้ยงสัตว์ 

     ในปี พ.ศ.2562 ของอ าเภอแม่พริก จังหวัดล าปาง 

2. เปรียบเทียบค่าประสิทธิภาพ (NDVI,NDBI) ของข้าวโพดเลี้ยงสัตว์ 

1.3 ประโยชน์ที่ขาดว่าจะได้รับ 

1. เพื่อให้ทราบวิธีการประยุกต์ใช้เทคนิคการรบัรู้จากระยะไกลและระบบสารสนเทศภูมิศาสตร์ใน

การติดตามการเพาะปลูกข้าวโพดเลี้ยงสัตว์ 

2. เพื่อให้ทราบถึงความแม่นย าของ NDVI,NDBI ในการติดตามการเพาะปลูกข้าวโพดเลี้ยงสัตว์ 

3. เพื่อให้ทราบหลักการของการใช้เทคนิคการรับรู้จากระยะไกล 
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1.4 ขอบเขตของงานวิจัย 

1. พื้นที่ศึกษาครอบคลุมทั้งหมดของพื้นที่อ าเภอแม่พริก จังหวัดล าปาง 

2. ศึกษาการติดตามการเพาะปลูกข้าวโพดเลี้ยงสัตว์ด้วยเทคนิค NDVI และ NDBI จากดาวเทียม 

Sentinel-2 ท าการเปรียบเทียบถึงศักยภาพในการผลิตข้าวโพดเลี้ยงสัตว์ของ อ าเภอแม่พริก  

จังหวัดล าปาง 

1.5 ขอบเขตการศกึษา 

1.5.1 ขอบเขตพื้นทีศ่ึกษา 

     พื้นที่ศึกษาครอบคลุมทั้งหมดของพื้นที่ อ าเภอแม่พริก จังหวัดล าปาง ตั้งอยู่ที่ภาคเหนืออยู่ทางทิศ

ตะวันตกเฉียงใต้ของจังหวัด ที่ตั้งทางภูมิศาสตร์ 17 องศา 26 ลิปดา 54 ฟิลิปดาเหนือ และ 99 องศา 

6 ลิปดา 54 ฟิลิปดาตะวันออก มีพื้นที่ทั้งหมด 538.921 ตร.กม. (208.079 ตร.ไมล์)มีประชากร

ทั้งหมด 16,021 คน ความหนาแน่นของประชากร 29.72 คน/ตร.กม. (77.0 คน/ตร.ไมล์)อยู่สูงจาก

ระดับน้ าทะเล 268.80 เมตร มีอาณาเขตติดต่อกับเขตการปกครองข้างเคียงดังนี้  ทิศเหนือ ติดต่อกับ

อ าเภอลี้ (จังหวัดล าพูน) และอ าเภอเถิน 

       ทิศตะวันออก ติดต่อกับอ าเภอเถิน 

       ทิศใต้ ติดต่อกับอ าเภอบ้านตากและอ าเภอสามเงา (จังหวัดตาก) 

       ทิศตะวันตก ติดต่อกับอ าเภอสามเงา (จังหวัดตาก) และอ าเภอลี้ (จังหวัดล าพูน) 

ภาพที่ 1.1 แผนที่แสดงขอบเขตอ าเภอแม่พริก จังหวัดล าปาง 
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1.5.2 ลักษณะทั่วไปของอ าเภอแม่พริก จังหวัดล าปาง 

อ าเภอแม่พริกมีหมู่บ้าน จ านวน 11 หมู่บ้าน ได้แก่ 1.บ้านแม่พริกลุ่ม 2.บ้านท่าด่าน 3.บ้าน

แม่เชียงรายลุ่ม 4.บ้านแม่พริกบน 5.บ้านสันป่าสัก 6.บ้านวังส าราญ 7.บ้านห้วยขี้นก 8.บ้านปางยาว 

9.บ้านร่มไม้ยาง 10.บ้านสันขี้เหล็ก 11.บ้านแพะดอกเข็ม 

1.5.3 สภาพอากาศ 

จากลักษณะภูมิประเทศของจังหวัดที่คล้ายอ่างกระทะ จึงท าให้อากาศร้อนอบอ้าวเกือบ

ตลอดปี  ฤดูร้อนจะร้อนจัด ปี 2559 มีอุณหภูมิสูงสุด 41.50 องศาเซลเซียส และฤดูหนาวจะหนาวจัด

อุณหภูมิต่ าสุด 14.30 องศาเซลเซียส 

ลักษณะภูมิอากาศ  จังหวัดล าปางมีลักษณะภูมิอากาศแบ่งออกเป็น 3 ฤดู 

1. ฤดูร้อน เริ่มประมาณเดือนมีนาคมจนถึงกลางเดือนพฤษภาคม ช่วงที่มีอากาศร้อนจัดที่สุด  

คือ เดือนเมษายน 

2. ฤดูฝน เริ่มประมาณกลางเดือนพฤษภาคม 

3. ฤดูหนาว เริ่มประมาณเดือนพฤศจิกายนจนถึงช่วงเดือนกุมภาพันธ์ ช่วงอากาศหนาวจัด คือ 

เดือนมกราคม 

1.5.4 ขอบเขตด้านเนื้อหา 

ข้อมูลที่น ามาใช้ในการศึกษา 

1. ข้อมูลดาวเทียม Sentinel-2 บันทึกภาพในช่วงเดือนพฤษภาคม ปี2562 – มกราคม 

 ปี2563 

2. ข้อมูลการเพาะปลกูข้าวโพดของเกษตรกรอ าเภอแม่พริก จังหวัดล าปาง  

        ปีพ.ศ. 2562 – 2563 

1.6 นิยามศัพท์เฉพาะ 

การส ารวจจากระยะไกล  (Remote Sensing) หมายถึงเป็นเครื่องมือวัดไม่มีการสัมผัสกับสิ่งที่

ต้องการตรวจวัดโดยตรง กระท าการส ารวจโดยให้เครื่องวัดอยู่ห่างจากสิ่งที่ต้องการตรวจวัดข้อมูล

ที่ได้จากการถ่ายภาพทางเครื่องบินในระดับต่ า ที่เรียกว่า รูปถ่ายทางอากาศ (Aerial Photo) และ

ข้อมูลที่ได้จากการบันทึกภาพจากดาวเทียมในระดับสูงกว่า เรียกว่า ภาพถ่ายจากดาวเทียม 

(Satellite Image) การวิเคราะห์มี 2 แบบคือ 1.การวิเคราะห์ด้วยสายตา  
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2.การวิเคราะห์โดยใช้คอมพิวเตอร์ ผลจากการวิเคราะห์ไม่ว่าจะเป็นวิธีใดก็ตาม จะแสดงถึง

ลักษณะที่แท้จริงของพื้นที่ หรือของบริเวณที่ท าการศึกษา และผลจากการศึกษานี้ โดยมากจะอยู่

ในลักษณะแผนที่การจ าแนกประเภทการใช้ที่ดิน หรือแผนที่แยกประเภททรัพยากรต่างๆ 

(สืบค้นข้อมูลออนไลน ์22/10/2020: https://knowledgeofrs.weebly.com/) 

 

ดัชนีพืชพรรณ (Vegetation Index) คือ ค่าที่บอกถึงสัดส่วนของพืชพรรณที่ปกคลุมพื้นผิว

โดยค านวณจากการน าช่วงคลื่นที่เกี่ยวข้องกับพืชพรรณมาท าสัดส่วนซึ่งกันและกันซึ่งวิธีการ

ที่นิยมใช้งานมากวิธีหนึ่งเรียกว่า Normalized Difference Vegetation Index (NDVI) 

เป็นการน าค่าความแตกต่างของการสะท้อน ของพื้นผิว ระหว่างช่วงคลื่นใกล้อินฟราเรดกับ

ช่วงคลื่นตามองเห็นสีแดงมาท าสัดส่วนกับค่าผลบวกของทั้งสองช่วงคลื่นเพื่อนปรับให้เป็น

ลั ก ษ ณ ะ ก า ร ก ร ะ จ า ย แ บ บ ป ก ติ  ( สื บ ค้ น ข้ อ มู ล อ อ น ไ ล น์  2 6 / 1 0 / 2 0 2 0 : 

http://www.arcims.tmd.go.th/DailyDATA/drought%20index/documents/) 

 

ดัชนีสิ่งปลูกสร้าง (Normalized Difference Buil - up Index ; NDBI) วิเคราะห์ดัชนีผลต่างสิ่ง 

ปลูกสร้างเป็นการวิเคราะห์ความสัมพันธ์ระหว่างอุณหภูมิพื้นผิวในเมืองและประเภท การใช้ที่ดิน 

หรือ สิ่งปกคลุมดินโดยการวิเคราะห์ข้อมูลจากการตรวจจับดาวเทียมที่ โดยดูค่าการสะท้อนคลื่น

ของความหนาแน่น ของวัตถุสิ่งก่อสร้าง ทั้งกลางคืน และกลางวัน กับอุณหภูมิในแต่ละช่วงเวลา 

Dousset และ Gourmelon 

 

 

 

 

 

 

 

 

 

https://knowledgeofrs.weebly.com/
http://www.arcims.tmd.go.th/DailyDATA/drought%20index/documents/
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1.7 กรอบแนวคิดงานวิจัย 

 

 

 

 

 

 

                                           

 

 

 

  

  

  

                                                  

  

ภาพที่ 1.2 กรอบแนวคิดงานวิจัย  

 
  
  

    

  

ภาพถ่ายดาวเทียม Sentinel-2 

หาค่าดัชนีพชืพรรณ (NDVI) หาค่าดัชนีสิง่ปลูก (NDBI) 

ติดตามช่วงระยะการเจริญเติบโตของข้าวโพดเลี้ยงสัตว์ 

 

เปรียบเทียบค่าดัชนี 

 

สรุปผล 
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บทที่ 2 

เอกสารและงานวิจัยที่เกี่ยวข้อง 

ในการศึกษาวิจัยเรื่อง การใช้เทคนิค NDVI กับ NDBI ในการติดตามการเจริญเติบโตของข้าวโพดเลี้ยงสัตว์ 

อ าเภอแม่พริก จังหวัดล าปาง ได้มีการศึกษา ค้นคว้าเอกสารและผลงานที่เกี่ยวข้อง เพื่อเป็นแนวทางในการ 

วิจัยครั้งนี้ด้วย 

1. การศึกษาการเพาะปลูกข้าวโพดเลี้ยงสัตว์  

2. ทฤษฎีที่น ามาใช้ในการศึกษา  

3. ดัชนีพืชพรรณ (NDVI)  

4. ดัชนีสิ่งปลกูสร้าง (NDBI)  

5. งานวิจัยที่เกี่ยวข้อง  

2.1 การศึกษาการเพาะปลูกข้าวโพดเลี้ยงสัตว ์ 

 2.1.1 ฤดูกาลผลิตข้าวโพดเลี้ยงสัตว ์

ข้าวโพดเลี้ยงสัตว์เป็นพืชไร่ที่ปลูกและดูแลง่าย สามารถปลูกข้าวโพดได้ตลอดทั้งปี เกษตรกรส่วนใหญ่

นิยมปลูกข้าวโพดเลี้ยงสัตว์โดยอาศัยน้ าฝนธรรมชาติเป็นหลัก ฤดูปลูกข้าวโพดเลี้ยงสัตว์ที่เหมาะสมจึงขึ้นอยู่กับ

ปริมาณน้ าฝนและการกระจายตัวของน้ าฝนในแต่ละเดือนโดยทั่วไปฤดูกาลการปลูกข้าวโพดเลี้ยงสัตว์ แบ่งเป็น 

2 รุ่น ได้แก่ ข้าวโพดเลี้ยงสัตว์รุ่นที่ 1 หรือรุ่นฤดูฝน กับ ข้าวโพดเลี้ยงสัตว์รุ่นที่ 2 หรือข้าวโพดเลี้ยงสัตว์หลังนา 

1. ข้าวโพดเลี้ยงสัตว์รุ่นที่ 1 หรือรุ่นฤดูฝน 

ข้าวโพดเลี้ยงสัตว์รุ่นที่ 1 ปลูกโดยอาศัยน้ าฝนตามฤดูกาลเป็นหลักแบ่งระยะการปลูกได้ 2 ช่วง คือ 

ปลูกช่วงต้นฤดูฝน (เมษายน – มิถุนายน) การปลูกข้าวโพดเลี้ยงสัตว์ในช่วงต้นฤดูฝนอาจจะเจอปัญหาฝนทิ้ง

ช่วงในเดือนมิถุนายน – กรกฎาคม ซึ่งเป็นข้าวโพดก าลังออกดอกหากฝนไม่ทิ้งช่วงหรือฝนตกอย่างสม่ าเสมอ 

ข้าวโพดเลี้ยงสัตว์จะให้ผลผลิตสูงกว่าการปลูกในปลายฝนประมาณร้อยละ 20 – 25 เนื่องจากมีช่วงแสงที่

ยาวนานกว่าเสี่ยงเจอปัญหาช่วงเก็บเกี่ยวผลผลิตในเดือนสิงหาคม – กันยายน ซึ่งเป็นระยะเวลาที่มีฝนตกหนัก 

ท าให้เก็บเกี่ยวผลผลิตล าบากและฝักหรือเมล็ดข้าวโพดเลี้ยงสัตว์ที่เก็บเกี่ยวในรุ่นนี้มักมีความชื้นสูงเสี่ยงต่อการ

เข้าท าลายของเชื้อรา เกษตรกรส่วนใหญ่นิยมปลูกข้าวโพดเลี้ยงสัตว์ในช่วงปลายฝน (กรกฎาคม – สิงหาคม) 

เพราะไม่ค่อยเจอปัญหาฝนทิ้งช่วงและข้าวโพดเลี้ยงสัตว์ไม่ค่อยเจอปัญหาเรื่องสารพิษ เพราะเก็บเกี่ยวในช่วงที่

มีความชื้นในอากาศต่ า แต่ปัญหาที่พบของข้าวโพดเลี้ยงสัตว์รุ่นนี้ คือ เสี่ยงโรคน้ าค้างระบาดสร้างความ
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เสียหายแก่ผลผลิตดังนั้น เกษตรกรที่ปลูกข้าวโพดเลี้ยงสัตว์รุ่นนี้ควรเลือกสายพันธุ์ข้าวโพดเลี้ยงสัตว์ที่ต้านทาน

โรคราน้ าค้างได้ดี 

 

  
ภาพที่ 2.1 โรคราน้ าค้างที่พบในขา้วโพดเลี้ยงสัตว์   

  

2. ข้าวโพดเลี้ยงสัตว์รุ่นที่ 2 หรือ ข้าวโพดเลี้ยงสัตว์หลังนา  

ข้าวโพดเลี้ยงสัตว์รุ่นที่ 2 เป็นการปลูกข้าวโพดเลี้ยงสัตว์ช่วงฤดูแล้ง ส่วนใหญ่มักปลูกในช่วงเดือน 

พฤศจิกายน – กุมภาพันธ์ เก็บเกี่ยวผลผลิตในช่วงเดือนกุมภาพันธ์ – พฤษภาคม เกษตรกรนิยมปลูกข้าวโพด

เลี้ยงสัตว์หลังนาปีโดยใช้แหล่งน้ าชลประทาน หรือแหล่งน้ าตามธรรมชาติ ข้อดีของข้าวโพดเลี้ยงสัตว์รุ่นนี้คือ  

ผลผลิตปลอดภัยจากปัญหาเช้ือรามากกว่าข้าวโพดเลี้ยงสัตว์ที่ปลูกช่วงต้นฤดูฝน 

การปลูกข้าวโพดเลี้ยงสัตว์หลังนา ช่วงเวลาที่เหมาะสมที่สุดคือตั้งแต่เดือนพฤศจิกายน - ธันวาคม 

เพราะระยะออกดอกไม่ตรงกับช่วงอุณหภูมิสูงเกินไป จนเป็นอุปสรรคต่อการออกดอกและผสมเกสร ประกอบ

กับในช่วงฤดูแล้งท้องฟ้าไม่ค่อยมีเมฆมาก ต้นข้าวโพดเลี้ยงสัตว์มีโอกาสได้รับแสงแดดอย่างเต็มที่ ท าให้ได้ผล

ผลิตสูง   
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2.1.2 การเตรียมดินให้เหมาะสมต่อการปลูกข้าวโพดเลี้ยงสัตว์ 

หากปลูกข้าวโพดเลี้ยงสัตว์ในแปลงนาที่ดินไม่สม่ าเสมอ จ าเป็นต้องมีการเตรียมดินตั้งแต่ฤดูการ ท านา 

คือ ไถดะและไถแปรพื้นที่นาเพื่อก าจัดวัชพืช และปรับพื้นที่ให้ราบเรียบสม่ าเสมอ เพื่อสะดวกในการให้น้ าและ

ระบายน้ าออกจากแปลง พื้นที่นาควรมีหน้าดินลึกไม่ต่ ากว่า 30 เซนติเมตร เพื่อให้รากข้าวโพดเลี้ยงสัตว์

สามารถเจริญเติบโต ดูดใช้น้ าและอาหารจากหน้าดินได้ดี กรณีที่ดินนาเป็นกรดหรือกรดจัด (pH < 5.5) ควร

ปรับปรุงดินก่อนปลูกข้าวโพดเลี้ยงสัตว์โดยการใส่ปูนขาว หรือปูนมาร์ล ในอัตราส่วนที่เหมาะสม 

ส าหรับแปลงนาที่เก็บเกี่ยวข้าวเสร็จแล้ว อาจมีเศษฟางและตอซังข้าวหนา ซึ่งเป็นอุปสรรคในการใช้

เครื่องหยอดข้าวโพด เกษตรกรควรหมักฟางข้าวให้เปื่อยในระหว่างการเตรียมดิน และใช้โรตารีตีหมกฟางคลุก

ลงดิน หลังจากนั้นสูบน้ าใส่ให้ท่วม หมักทิ้งไว้ 7 วันก่อนไขน้ าออกและตากดินประมาณ 2 สัปดาห์ จึงค่อย

เตรียมดิน ทั้งนี้ควรหลีกเลี่ยงการเผาฟางข้าวในแปลงนา เพื่อเป็นการอนุรักษ์ดินและน้ าในดิน ข้าวโพดเลี้ยง

สัตว์ชอบดินที่มีลักษณะโปร่งและระบายน้ าดี โดยทั่วไปวิธีการเตรียมดินที่เหมาะสมส าหรับการปลูกข้าวโพด

เลี้ยงสัตว์หลังนา เริ่มจากการไถดะโดยใช้รถไถผ่าน 3 หรือรถไถเดินตาม หลังเก็บเกี่ยวข้าว ตากแปลงไว้อย่าง

น้อย 5 - 7 วัน เพื่อท าลายวัชพืชก่อน จึงไถแปรโดยใช้รถไถผ่าน 7 ไถย่อยดินให้ร่วนซุยเพื่อเก็บกักความชื้นใน

ดินและให้มีสภาพเหมาะแก่การเพาะปลูก 

2.1.3 การจัดการแปลงปลูก 

 การปลูกข้าวโพดเลี้ยงสัตว์ในพื้นที่นา ควรปลูกแบบเป็นแถว โดยใช้แรงคนหรือรถไถที่ติดท้าย

เครื่องหยอดข้าวโพด พร้อมใส่ปุ๋ยรองพื้นและไถดินกลบไปพร้อมกัน วิธีนี้มีข้อดีคือ ประหยัดเวลา ประหยัด

ค่าแรงเมล็ดข้าวโพดเลี้ยงสัตว์ที่งอกแล้วสามารถใช้ปุ๋ยได้ทันที และมีปุ๋ยบ ารุงต้นจนอายุครบ 1 เดือน  ท าให้

โครงสร้างของล าต้นข้าวโพดเลี้ยงสัตว์เติบโตสมบูรณ์ตั้งแต่ยังเล็ก  ช่วยให้ต้นข้าวโพดเลี้ยงสัตว์เติบโตสม่ าเสมอ

เท่ากันทั้งแปลง 
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ภาพที่ 2.2 การจัดการแปลงปลูกข้าวโพดเลี้ยงสัตว ์

       การปลูกข้าวโพดเลี้ยงสัตว์ ที่ท าให้ได้ผลผลิตเหมาะสม โดยทั่วไปมีการจัดการแปลงปลูก 2 รูปแบบ 

1. ปลูกแบบแถวเดี่ยว ให้เว้นระยะหยอดระหว่างแถว 75 เซนติเมตร และปลูกระยะห่าง 20 - 

25 เซนติเมตร หยอดเมล็ดข้าวโพดลง 1 - 2 เมล็ด/หลุม (จ านวนต้นต่อไร่ ประมาณ 8,500 

- 10,600 ต้น จะใช้เมล็ดข้าวโพดประมาณ 3.0 - 3.5 กิโลกรัมต่อไร่) 

2. การปลูกแบบแถวคู่ มีการยกร่องสูงเว้นระยะร่องละ 120 เซนติเมตรปลูกเป็นสองแถว ข้าง

ร่องเว้นระยะห่าง 30 เซนติเมตร ปลูกห่างต้นละ 20 - 25 เซนติเมตรแนะน าปลูก 

 1 - 2 ต้นต่อหลุม จะมีจ านวนต้นประมาณ 8,500 - 10,600 ต้นต่อไร่ และใช้เมล็ดข้าวโพด

ประมาณ 3.0 - 3.5 กิโลกรัมต่อไร่) 

2.1.3 การให้น้ าที่เหมาะสม 

ข้าวโพดเลี้ยงสัตว์รุ่นฤดูฝนที่ปลูกในพื้นที่ลาดชัน เขตภาคเหนือ เรื่องการดูแลจัดการน้ าท าได้ยาก 

เพราะปลูกโดยอาศัยน้ าฝนตามธรรมชาติเป็นหลัก  ส่วนการปลูกข้าวโพดเลี้ยงสัตว์หลังนา โดยอาศัยแหล่งน้ า

ธรรมชาติหรือน้ าบ่อในแปลงนา สามารถดูแลจัดการน้ าได้ง่ายกว่า โดยสูบน้ าปล่อยไปตามร่อง ให้ดินชุ่มชื้น

ตลอดฤดูการปลูกก็เพียงพอแล้ว แต่ไม่ควรปล่อยให้น้ าท่วมขังเป็นเวลานาน เพราะจะท าให้ต้นข้าวโพดเลี้ยง

สัตว์เหลืองแคระแกร็น ผลผลิตลดลง และอาจตายได้  กรณีมีน้ าท่วมขังในแปลง ควรรีบระบายน้ าออกจาก

แปลงทันที 
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ส าหรับเกษตรกรที่ปลูกข้าวโพดเลี้ยงสัตว์หลังนา โดยอาศัยความชื้นในดินที่หลงเหลืออยู่หลังเก็บเกี่ยว

ข้าว หากพบว่า ดินมีความชื้นไม่เพียงพอส าหรับการงอกและการเจริญเติบโตในระยะแรก (1 - 2 สัปดาห์) ควร

ให้น้ าก่อนปลูก โดยไถดะพร้อมกับปล่อยน้ าเข้าแปลง เมื่อดินมีความชื้นเหมาะสม ให้ไถดะพร้อมคราดเพื่อเก็บ

รักษาความชื้นและเพื่อให้มีสภาพเหมาะสมต่อการเพาะปลูกจากนั้นให้น้ าครั้งแรกหลังปลูกและให้น้ าครั้งต่อไป

เมื่อดินแห้งหรือสังเกตอาการเหี่ยวของใบข้าวโพดเลี้ยงสัตว์ในช่วงบ่าย 

2.1.4 การให้ปุ๋ย  

ปุ๋ย เป็นแหล่งธาตุอาหารที่ส าคัญของข้าวโพดเลี้ยงสัตว์ โดยเฉพาะธาตุอาหารหลัก ไนโตรเจน 

ฟอสฟอรัสและโพแทสเซียม ดังนั้นเกษตรกรควรใช้ปุ๋ยให้ถูกสูตร ถูกเวลา ถูกวิธี และในปริมาณที่เหมาะสม ซึ่ง

จะช่วยเพิ่มปริมาณและคุณภาพผลผลิตที่ดี ฝักใหญ่ เมล็ดเต็มฝัก การใส่ปุ๋ยบ ารุงต้นข้าวโพดเลี้ยงสัตว์แบ่งเป็น 

2 ช่วง 

ช่วงที่ 1 เป็นการใส่ปุ๋ยรองพื้นแนะน าปุ๋ยตรากระต่ายรองพื้นสูตร 15-15-15 หรือ   16-20-0 หรือ16-

16-8 หรือ 16-8-8 อัตรา 30 – 50 กิโลกรัมต่อไร ่

ช่วงที่ 2  เป็นการใส่ปุ๋ยแต่งหน้าเมื่อข้าวโพดเลี้ยงสัตว์มีอายุ 40 – 45 วันหลังปลูก (ใกล้ออกไหม) 

ในช่วงนี้หากสังเกตว่าต้นข้าวโพดเลี้ยงสัตว์แสดงอาการเหลือง หรือไม่สมบูรณ์ให้ใส่ปุ๋ยตรากระต่ายสูตร 46-0-0 

อัตรา 25 – 30 กิโลกรัมต่อไร่ โรยข้างต้นข้าวโพดเลี้ยงสัตว์ในขณะที่ดินมีความชื้นหรือให้น้ าตาม 

2.1.5 การป้องกันก าจัดวัชพืชในแปลงปลูกข้าวโพดเลี้ยงสัตว์ 

เมื่อต้นข้าวโพดเลี้ยงสัตว์อายุ 20 – 25 วัน เกษตรกรควรก าจัดพืชระหว่างแถวปลูกและใส่สูตรยูเรีย  

46-0-0 อีกครั้งโรยข้างแถวแล้วพรวนดินแถกร่องกลบด้วยแรงงานคนหรือเครื่องจักรกล ควรด าเนินการให้แล้ว

เสร็จก่อนการให้น้ าครั้งแรก ส าหรับวัชพืชที่พบในแปลงปลูกข้าวโพดเลี้ยงสัตว์มักเกิดมาจากเมล็ดหรือส่วน

ขยายพันธุ์พืชอื่นๆ ที่ตกค้างอยู่ในดินและสามารถงอกได้ทันทีที่ได้รับความชื้นในดินปริมาณวัชพืชมากหรือน้อย

ขึ้นอยู่กับการให้น้ าด้วยเช่นเดียวกัน การให้น้ าบ่อยมีแนวโน้มท าให้ปริมาณวัชพืชเพิ่มขึ้นตามไปด้วย โดยเฉพาะ

การให้น้ าแบบท่วมสันร่อง จึงควรหลีกเลี่ยงการให้น้ าลักษณะนี้ เพื่อลดปริมาณวัชพืชในแปลงปลูกข้าวโพด

เลี้ยงสัตว์ หากเกษตรกรปล่อยให้วัชพืชขึ้นในแปลงปลูกข้าวโพดเลี้ยงสัตว์จะท าให้วัชพืชแย่งอาหารกับต้น

ข้าวโพดเลี้ยงสัตว์อย่างรุนแรง ท าให้ผลผลิตลดลงถึง 80 เปอร์เซ็นต์ต้นข้าวโพดเลี้ยงสัตว์มักอ่อนแอต่อวัชพืช

ที่สุดในช่วงอายุ 13 – 25 วัน 
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 หลังงอกระยะนี้หากมีวัชพืชรบกวนจะท าให้ผลผลิตข้าวโพดเลี้ยงสัตว์เสียหายสูงสุด การใช้สารเคมี

ก าจัดวัชพืชจึงเป็นทางเลือกในการจัดการวัชพืช ส าหรับการปลูกข้าวโพดเลี้ยงสัตว์หลังนาแนะน าให้เกษตรกร

ใช้สารควบคุมวัชพืชหลังปลูก ก่อนข้าวโพดงอกและครั้งที่ 2 การท ารุ่นเป็นการก าจัดวัชพืชระหว่างแถวปลูก

ด้วยแรงงานหรือเครื่องจักรกล เมื่อข้าวโพดอายุ 20 – 25 วัน พร้อมให้ปุ๋ยหรืออาจใช้สารเคมีหลังวัชพืชและ

ข้าวโพดเลี้ยงสัตว์งอก ซึ่งต้องใช้อย่างถูกต้องเหมาะสม 

ส าหรับการก าจัดวัชพืชแนะน า คลีโอ-โปร เป็นสารเคมีก าจัดวัชพืชในไร่ข้าวโพดเลี้ยงสัตว์ที่ได้รับความ

นิยมสูงในขณะนี้เนื่องจากคลีโอ-โปร มีสิทธิภาพ 3 ตัวครบ จบในเรื่องเดียวคือ การคุม ฆ่าหญ้าและมีสารเสริม

ประสิทธิภาพ ช่วยให้น้ ายาเกาะติดใบหญ้าออกฤทธิ์คุม ฆ่า ได้อย่างเต็มประสิทธิภาพ สามารถก าจัดได้ทั้งหญ้า

ใบแคบและใบกว้างในไร่ข้าวโพดเลี้ยงสัตว์ได้ทุกสายพันธุ์ช่วยประหยัดและลดต้นทุนสารเคมีก าวัชพืชในไร่

ข้าวโพดเลี้ยงสัตว์ได้อย่างด ี

2.1.6 การป้องกันโรคแมลงศัตรูพืช 

หนอนกระทู้ข้าวโพดลายจุด นับเป็นศัตรูส าคัญของข้าวโพดเลี้ยงสัตว์ ผีเสื้อหนอนกระทู้ข้าวโพดหลาย

จุดมักวางไข่บนใบข้าวโพดอย่างต่อเนื่องโดยวางไข่มากในช่วงระยะ 3 สัปดาห์แรกหลังจากข้าวโพดเลี้ยงสัตว์

งอกเกษตรกรจึงควนหมั่นส ารวจแปลงหลังจากข้าวโพดงอกสังเกตกลุ่มไข่และรอยท าลายสีขาวที่ผิวใบ ต้นถูก

ท าลายจนมีรอยกัดขาดเป็นรู ควรป้องกันก าจัดโดยฉีดพ่นสารลงในกรวยยอด การคลุกเมล็ดพันธุ์ข้าวโพดเลี้ยง

สัตว์ด้วยสารเคมีป้องกันก าจัดแมลงก่อนปลูกสามารถลดปัญหาหนอนกระทู้ข้าวโพดลายจุดลงมาเจาะที่โคนต้น

ได้ทั้งนี้เกษตรกรควรมีการติตตามส ารวจแปลงปลูกข้าวโพดเลี้ยงสัตว์อย่างสม่ าเสมอ 

 

 

 

 

 ภาพที่ 2.3 ภาพหนอนกระทู้ลายจุด 
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2.1.7 การเก็บเกี่ยว 

เกษตรกรควรเก็บเกี่ยวผลผลิตเมื่อข้าวโพดเลี้ยงสัตว์แก่จัดและแห้งสนิท (อายุประมาณ 120 วันหลัง

ปลูกขึ้นอยู่กับพันธุ์) ต้นข้าวโพดเลี้ยงสัตว์จะมีลักษณะแห้งและเปลี่ยนเป็นสีฟางขาวหมดทั้งแปลงและเมล็ด

ข้าวโพดเลี้ยงสัตว์จะมีความชื้นสูงควรปล่อยให้ฝักและต้นข้าวโพดเลี้ยงสัตว์แห้งก่อนเก็บเกี่ยว 

       ข้อแนะน าและข้อระวังส าหรับการปลูกข้าวโพดเลี้ยงสัตว์ 

1. ไม่ควรให้น้ าหลังการปลูกทันที เพราะอาจเป็นอุปสรรคต่อการงอก เนื่องจากดินอัดแน่นเมล็ด

ข้าวโพดเลี้ยงสัตว์ไม่สามารถงอกได้ท าให้เมล็ดเน่าเสียหาย 

2. การปลูกข้าวโพดเลี้ยงสัตว์แบบพื้นราบควรให้น้ าก่อนปลูก ส่วนแปลงปลูกข้าวโพดเลี้ยงสัตว์

แบบกร่องควรท าการปลูกก่อนให้น้ าในแปลง 

3. หากปลูกข้าวโพดเลี้ยงสัตว์ในช่วงที่มีอุณหภูมิค่อนข้างต่ าเมล็ดอาจงอกช้า 

4. การปลูกล่าช้าหลังเดือนธันวาคม ท าให้ระยะออกดอกตรงกับช่วงอุณหภูมิสูง อาจท าให้ช่อ

ดอกและไหมแห้ง ผสมไม่ติด ท าให้เมล็ดติดไม่เต็มฝัก 

5. ผลกระทบจากการเปลี่ยนแปลงสภาพภูมิอากาศท าให้การผลิตข้าวโพดเลี้ยงสัตว์ของ

เกษตรกรมีความเสี่ยงเพ่ิมขึ้นต่อสภาพฝนแล้งฝนทิ้งช่วงหรือน้ าท่วม รวมทั้งเกิดโรคและแมลง

ได้ง่ายการจัดการที่ผิดวิธี ผิดที่ และผิดเวลา หรือใช้สารฆ่าแมลงซ้ าอยู่ชนิดเดียวเสี่ยงท าให้

แมลงดื้อยาเร็วแนะน าให้แก้ปัญหาโดยใช้หลายวิธีร่วมกัน เพื่อให้เกิดประสิทธิภาพในการ

ป้องกันก าจัดแมลงที่ด ี

 

 

2.2 การส ารวจระยะไกล (Remote Sensing) 

เป็นการส ารวจจากระยะไกล โดยเครื่องมือวัดไม่มีการสัมผัสกับสิ่งที่ต้องการตรวจวัดโดยตรง กระท า

การส ารวจโดยให้เครื่องวัดอยู่ห่างจากสิ่งที่ต้องการตรวจวัด โดยอาจติดตั้งเครื่องวัดเช่น กล้องถ่ายภาพ ไว้ยังที่

สูง บนบอลลูน บนเครื่องบิน ยาวอวกาศ หรือดาวเทียม แล้วอาศัยคลื่นแม่เหล็กไฟฟ้าที่แผ่ หรือสะท้อนมาจาก

สิ่งที่ต้องการส ารวจเป็นสื่อในการวัด การส ารวจโดยใช้วิธีนี้เป็นการเก็บข้อมูลที่ได้ข้อมูลจ านวนมาก ในบริเวณ

กว้างกว่าการส ารวจภาพสนาม จากการใช้เครื่องมือส ารวจระยะไกล โดยเครื่องมือส ารวจไม่จ าเป็นที่ต้องสัมผัส

กับวัตถุตัวอย่าง เช่น เครื่องบินส ารวจเพื่อถ่ายภาพในระยะไกล การใช้ดาวเทียมส ารวจทรัพยากรท าการเก็บ

ข้อมูลพื้นผิวโลกในระยะไกล 
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2.2.1 หลักการท างานของดาวเทียมส ารวจทรัพยากร 

การส ารวจข้อมูลทรัพยากรจากระยะไกล ท าได้โดยอาศัยพลังงานแม่เหล็กไฟฟ้า ซึ่งมีอยู่ทั่ วไปใน

บรรยากาศรอบตัวเรา ส าหรับเป็นพาหะในการสื่อข่าวสารเกี่ยวกับทรัพยากรต่างๆ รวมทั้งทรัพยากรการเกษตร

ที่เราสนใจด้วย วัตถุทุกอย่างในโลกมีคุณสมบัติทางแม่เหล็กไฟฟ้าต่างกัน เมื่อน าเครื่องมือบันทึกข้อมูลขึ้นไปกับ

ดาวเทียม เครื่องมือน้ันจะท าการบันทึกข้อมูล ซึ่งบอกถึงลักษณะต่างๆ ของวัตถุ หรือเหตุการณ์ต่างๆ ได้ ข้อมูล

เบื้องต้นที่ได้มาอาจอยู่ในลักษณะตัวเลข ซึ่งบันทึกไว้ในจานแม่เหล็ก หรือในรูปของภาพถ่าย ซึ่งยังถือว่า เป็น

ข้อมูลดิบอยู่ จะต้องน าไปวิเคราะห์ให้ได้รายละเอียดของข่าวสาร (สนเทศ) อย่างถูกต้องก่อน ซึ่งท าได้ 2 วิธี คือ 

การวิเคราะห์ด้วยสายตา และการวิเคราะห์โดยใช้คอมพิวเตอร์ ผลจากการวิเคราะห์ไม่ว่าจะเป็นวิธีใดก็ตาม จะ

แสดงถึงลักษณะที่แท้จริงของพื้นที่ หรือของบริเวณที่ท าการศึกษา และผลจากการศึกษานี้ โดยมากจะอยู่ใน

ลักษณะแผนที่การจ าแนกประเภทการใช้ที่ดิน หรือแผนที่แยกประเภททรัพยากรต่างๆ 

2.2.2 ดาวเทียม Sentinel-2 

Sentinel เป็นโครงการดาวเทียมส ารวจทรัพยากรของ EU Copernicus Programme โดยโครงการ 

sentinel2 ด าเนินการภายใต้การดูแลของ European Space Agenc yปัจจุบันมีดาวเทียม 2 ดวง( identical)

ท าการส ารวจเก็บข้อมูลร่วมกันคือ Sentinel-2A(launch 2015) และ Sentinel-2B(launch 2017) ระบบ

บันทึกข้อมูลภาพของ sentinel รองรับ 13 ย่านความถี่แบบ MS จาก visible, near infrared,และ short 

wave infrared ข้อมูลภาพระดับ High spatial resolution (10-60 m) มีพื้นที่ท าการครอบคลุมทั่วโลก ทั้ง

ภาคพื้นดินและมหาสมุทร มีรองการบันทึกข้อมูลซ้ าทุกๆ 5 วัน  

Sentinel ถูกพัฒนาขึ้นเพื่อรองรับ application ต่างๆ เช่นการเกษตร , การส ารวจทรัพยกร , การจัดการภัย

พิบัติ ,การจัดการทรัพยากรน้ า และอื่นๆ 
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ตารางที่ 2.1 คุณลักษณะของดาวเทียม Sentinel-2 

 (ที่มา https://medium.com/geo-datascience/download-sentinel-2-high-resolution-optical-

images-with-python-2581c6fecd0e) 

2.3 วิเคราะหด์ัชนีผลต่างพชืพรรณ (Normalized Difference Vegetation Index: NDVI) 

ดัชนีพืชพรรณ (Vegetation Index) คือค่าที่บอกถึงสัดส่วนของพืชพรรณที่พื้นผิวโดยค านวณ

จากการน าช่วงคลื่นที่เกี่ยวข้องกับพืชพรรณมาท าส่วนซึ่งกันและกัน ซึ่งวิธีการที่นิยมใช้งานมากวิธีหนึ่ง

เรียกว่า Normalized Difference Vegetation Index (NDVI) เป็นการน าค่าความแตกต่างของการ

สะท้อน ของพื้นผิว ระหว่างช่วงคลื่นใกล้อินฟราเรดกับช่วงคลื่นตามองเห็นสีแดงมาท าสัดส่วนกับค่า

ผลบวกของทั้งสองช่วงคลื่นเพื่อปรับให้เป็นลักษณะการกระจายแบบปกติดังสมการที่ (1) ท าให้ NDVI 

มีค่าอยู่ระหว่าง -1 ถึง 1 จะช่วยในการแปลผลได้ง่ายขึ้น กล่าวคือค่า 0 หมายถึงไม่มีพืชพรรณใบเขียว

อยู่ในพื้นที่ส ารวจในขณะที่ค่า 0.8 หรือ 0.9 หมายถึงมีพวกพืชพรรณใบเขียวหนาแน่นมากในพืชที่

ดังกล่าว กรณีที่พื้นผิวมีพืชพรรณปกคลุมจะมีค่าการสะท้อนในช่วงคลื่นใกล้อินฟราเรดสูงกว่าช่วงคลื่น

ตามองเห็นสีแดงท าให้ NDVI มีค่าเป็นบวกในขณะที่พื้นผิวเป็นดินจะมีค่าการสะท้อนระหว่างสองช่วง

คลื่นใกล้เคียงกันท าให้ NDVI มีค่าใกล้เคียงกับศูนย์ ส่วนกรณีที่พื้นผิวเป็นน้ าจะมีค่าการสะท้อนในช่วง

คลื่นใกล้อินฟราเรดต่ ากว่าช่วงคลื่นตามองเห็นสีแดง ท าให้ NDVI มีค่าติดลบทั้งนี้โดยปกติค่านี้จะมีค่า

อยู่ระหว่าง 0.1 ถึง 0.7 เท่านั้นโดยมีสมการดังนี้ 

                    NDVI = 
)(

)(

REDNIR

REDNIR



  

https://medium.com/geo-datascience/download-sentinel-2-high-resolution-optical-images-with-python-2581c6fecd0e
https://medium.com/geo-datascience/download-sentinel-2-high-resolution-optical-images-with-python-2581c6fecd0e
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NDVI คือ ดัชนีพืชพรรณโดยวิธี Normalized Difference Vegetation Index 

NIR   คือ การสะท้อนในช่วงคลื่นใกล้อินฟราเรด 

RED  คือ การสะท้อนในช่วงคลื่นที่ตามองเห็นแสงสีแดง 

2.4 วิเคราะหด์ัชนีผลต่างสิ่งปลูกสร้าง (Normalized Difference Buil - up Index : NDBI) 

วิเคราะห์ดัชนีผลต่างสิ่งปลูกสร้างเป็นการวิเคราะห์ความสัมพันธ์ระหว่างอุณหภูมิพื้นผิวในเมืองและ

ประเภทการใช้ที่ดินหรือ สิ่งปกคลุมดินโดยการวิเคราะห์ข้อมูลจากการตรวจจับดาวเทียมที่ โดยดูค่าการ

สะท้อนคลื่นของความหนาแน่นของวัตถุสิ่งก่อสร้าง ทั้งกลางคืน และกลางวัน กับอุณหภูมิในแต่ละช่วงเวลา 

Dousset และ Gourmelon (2003) ดังสมการ 

     NDBI = 
)(

)(

NIRSWIR

NIRSWIR



  

NDBI คือ ดัชนีสิ่งปลูกสร้าง                   

SWIR คือ การสะท้อนระหว่างช่วงคลื่นอินฟราเรดคลื่นสั้น 

NIR คือ การสะท้อนในช่วงคลื่นใกล้อินฟราเรด 
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2.5 เอกสารงานวิจัยที่เกี่ยวข้อง 

1) Statescu Florian,October (2017) ได้ศึกษาเกี่ยวกับการเปรียบเทียบดัชนีความแตกต่าง

ปกติ (NDBI) และดัชนีความแตกต่างพืชพรรณ (NDVI) โดยใช้ภาพถ่ายดาวเทียมของ Landsat-8 หา

ความสัมพันธ์ระหว่างอุณหภูมิพื้นผิวดิน (LST), NDBI และ NDVI เกาะความร้อนในเมือง (UHI) แสดง

ถึงปรากฏการณ์ของชั้นบรรยากาศและอุณหภูมิพื้นผิวที่สูงขึ้นที่เกิดขึ้นในเขตเมืองและชนบท Iasi ผล

การศึกษาพบว่าความสัมพันธ์ของ NDBI และ NDVI นั้นแตกต่างกันไปตามฤดูกาลโดยชี้ให้เห็นว่า 

NDBI เป็นตัวบ่งชี้ที่แม่นย าของเอฟเฟกต์ UHI บนพื้นผิวและสามารถใช้เป็นตัวชี้วัดที่เสริมให้กับ NDVI 

ที่ใช้แบบดั้งเดิม 

2) Tek Bahadur Kshetri, Published on September 30, (2018) ได้ศึกษาเก่ียวกับการ

วิเคราะห์การค านวณ NDVI, NDBI และ NDWI โดยใช้ Landsat 7, 8 สามารถแบ่งได้ตามความ

ละเอียดคลื่นแม่เหล็กไฟฟ้าแหล่งพลังงานสื่อภาพและจ านวนแถบความถี่ ความละเอียดของข้อมูล

ดาวเทียมที่สูงขึ้น (ความละเอียดเชิงพื้นที่ , ความละเอียดเชิงสเปกตรัม , ความละเอียดทาง 

radiometric, ความละเอียดชั่วคราว), ความแม่นย าในระดับที่สูงขึ้นจะเกิดขึ้นระหว่างการจ าแนก

ประเภท ข้อมูล Landsat มีความยาวคลื่น (แถบสีฟ้า, แถบสีเขียว, แถบสีแดง, แถบอินฟราเรด, แถบ

ความร้อน, การเปลี่ยนสี) Panchromatic band ใช้ส าหรับเพิ่มความละเอียด ข้อมูล Landsat 7 มี

ทั้งหมด 8 แบนด์ในขณะที่ข้อมูล Landsat 8 มี 11 ผลการศึกษาพบว่า ดัชนีส าหรับการวิเคราะห์

รูปแบบของเมืองใช้ NDBI และ NDVI ดัชนีบิวด์อินเป็นอิมเมจไบนารีที่มีค่าบวกสูงกว่าเท่านั้นบ่งชี้ว่ามี

บิวด์และบาร์เรนท าให้ BU สามารถแมปพื้นที่บิวด์อินโดยอัตโนมัต ิ

 

MNDWI = (Green – SWIR) / (Green + SWIR) 

For Landsat 7 data, NDWI = (Band 2 – Band 5) / (Band 2 + Band 5) 

For Landsat 8 data, NDWI = (Band 3 – Band 6) / (Band 3 + Band 6) 

 

ในขณะเดียวกันค่า Normalize Difference Water Index (NDWI) อยู่ระหว่าง -1 ถึง 1 โดยทั่วไปค่า

น้ า NDWI จะมากกว่า 0.5 พืชพรรณมีค่าน้อยกว่ามากซึ่งแยกแยะพืชพรรณจากแหล่งน้ าได้ง่าย 

คุณลักษณะการสะสมที่มีค่าบวกอยู่ระหว่าง 0 ถึง 0.2 
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3) วิจิตรา สว่างแจ้ง (2560) ได้ศึกษาเกี่ยวกับการประยุกต์ใช้ข้อมูลดาวเทียมในการศึกษา

ศักยภาพการผลิตมันส าปะหลัง ในเขตอ าเภอพรานกระต่าย จังหวัดก าแพงเพชร เก็บตัวเกษตรกรจ าน

วน 30 ราย มีค่าผลผลิตเฉลี่ยอยู่ที่ 3.7 ตันต่อไร่ และมีค่าเบี่ยงเบียนมาตรฐานอยู่ที่ 0.405 เมื่อ

เปรียบเทียบกับศักยภาพการผลิตของประเทศ ในปีการเพาะปลูก พ.ศ. 2559 พบว่าค่าเฉลี่ยมัน

ส าปะหลังของประเทศ เท่ากับ 3.4 ตันต่อไร่ และศึกษาทางสถิติพบว่าการผลิตมันส าปะหลังของ

เกษตรกรในอ าเภอพรานกระต่าย มีศักยภาพในการผลิตที่มีค่าสูงกว่าค่าระดับประเทศ อย่างมี

นัยส าคัญทางสถิต ิ

4) ภานุพันธุ์ ไมตรี (2561) ได้ศึกษาการประยุกต์ใช้ดัชนีพืชพรรณ (NDVI) ในการศึกษา

ศักยภาพการเพาะปลูกข้าวในพื้นที่ อ าเภอเชียงของ จังหวัดเชียงราย ท าการศึกษาการจ าแนกพื้นที่

เพาะปลูกข้าวโดยใช้ดัชนีพืชพรรณ (NDVI) และ ดัชนีความต่างค่า อินฟราเรด (NDII) ในการจ าแนก

พื้นที่และเปรียบหาความถูกต้องของเทคนิคทั้ง 2 ว่ามีประสิทธิภาพ แตกต่างกันหรือไม่ตามช่วง

ระยะเวลาการเจริญเติบโตแบ่งเป็น 4 ช่วงคือ ก่อนเพาะปลูก, เริ่มเพาะปลูก, เจริญเติบโต และ เก็บ

เกี่ยว เพื่อน ามาเปรียบเทียบค่าทางสถิติพบว่าค่าดัชนีพืชพรรณ (NDVI) ของข้าว มีค่าเฉลี่ย 0.03, 

0.04, 0.05 และ 0.05 ตามล าดับและค่าดัชนีความต่างค่าอินฟราเรด (NDII) ของ ข้าวมีค่าเฉลี่ย -

0.03, 0, -0.01 และ -0.02 ตามล าดับจากการลงพื้นที่เก็บข้อมูลจากเกษตรกรที่เพาะปลูก ข้าว 20 

รายพบว่ามีค่าเฉลี่ยผลผลิตเท่ากับ 677.5กิโลกรัมต่อไร่ เมื่อเทียบกับผลผลิตเฉลี่ยของประเทศไทยใน

ปีการเพาะปลูก พ.ศ.2559 พบว่าค่าเฉลี่ยข้าวระดับประเทศเท่ากับ 666 กิโลกรัมต่อไร่ จาก การ

วิเคราะห์พบว่าค่าเฉลี่ยผลผลิตข้าวพื้นที่อ าเภอเชียงของ จังหวัดเชียงราย มีค่าสูงกว่าค่าผลผลิต ข้าว

ระดับประเทศอย่างมีนัยส าคัญทางสถิติ 

 

 

 

 

 

 

 



18 
 

บทที่ 3 

    วิธีด าเนินงานวิจัย 

การศึกษาเรื่องการใช้เทคนิค NDVI กับ NDBI ในการติดตามการเจริญเติบโตของข้าวโพดเลี้ยงสัตว์กรณีศึกษา 

อ าเภอแม่พริก จังหวัดล าปาง เพื่อเปรียบเทียบค่าประสิทธิภาพ (NDVI,NDBI) ของข้าวโพดเลี้ยงสัตว์ว่าเทคนิค

ไหนมีความแม่นย ากว่ากัน 

ผู้วิจัยได้ก าหนดวิธีการศึกษาดังนี ้

 1 วิธีการศึกษา 

2 ข้อมูลและแหล่งข้อมูล 

3 เครื่องมือและโปรแกรมที่ใช้ 

4 การวิเคราะห์ข้อมูล 

3.1 วิธีการศึกษา 

 การวิจัยครั้งนี้ผู้วิจัยได้ใช้ข้อมูลภาพถ่ายดาวเทียมของ Sentinel-2 ในช่วงเดือน พฤษภาคม 2562 – 

มกราคม 2563 โดยแบ่งเป็น 3 ช่วงระยะเวลาการเจริญเติบโต โดยมีช่วงระยะเวลาดังนี้ 

ช่วงเริ่มเพราะปลูก 2.ช่วงเจริญเติบโต 3.ช่วงเก็บเกี่ยว และใช้เทคนิคดัชนีพืชพรรณ (NDVI) กับ 

เทคนิคดัชนีสิ่งปลูกสร้าง (NDBI)ในการจ าแนกพื้นที่เพาะปลูกข้าวโพดเลี้ยงสัตว์ในแต่ละช่วงที่ก าหนดไว้และน า

ผลที่ได้จากโปรแกรมน ามาวิเคราะห์ด้วยวิธีการทางสถิติเพื่อท าการเปรียบเทียบว่า 2 เทคนิคนี้ เทคนิคไหนให้

ความแม่นย าในการปลูกข้าวโพดเลี้ยงสัตว์มากกว่ากัน 

3.2 ข้อมูลและแหล่งข้อมูล 

 1. ภาพดาวเทียม Sentinel-2 ในช่วงเดือนพฤษภาคม ปี2562 - มกราคม ปี2563 

2. ข้อมูลการเพาะปลกูข้าวโพดของเกษตรกรอ าเภอแม่พริก จังหวัดล าปาง  

    ปี พ.ศ. 2562 – 2563 
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3.3 เครื่องมือและโปรแกรมที่ใช ้

 1. เว็บโหลดภาพ EarthExplorer 

 2. โปรแกรมระบบสารสนเทศทางภูมิศาสตร์ Arc Map 10.4.1 

 3. โปรแกรมประมวลผลภาพถ่าย Erdas Imagine 2014 

 4. โปรแกรมวิเคราะห์ข้อมูล Microsoft Exel 2016 

 5. โปรแกรมประมวลผลค่า Microsoft Word 2016 

3.4 การวิเคราะห์ข้อมูล 

1. การเลือกโหลดภาพถ่ายดาวเทียม Sentinel-2 ในช่วง เดือนพฤษภาคม ปี2562 – มกราคม    ปี

2563 

2. น าภาพถ่ายดาวเทียมแต่ละช่วงเวลามารวมแบนด์ 

3. ตัดขอบเขตพ้ืนที่ศึกษา 

4. น าข้อมูลพืน้ที่ ที่มีการเพาะปลูกข้าวโพดเลี้ยงสัตว์แสดงเป็นจุดต าแหน่งแปลง (Point) 

5. น าภาพถ่ายดาวเทียมมา Mosaic เพื่อที่จะให้ภาพถ่ายดาวเทียมต่อกัน 

6. น าภาพถ่ายดาวเทียมมาท าเป็น NDVI และ NDBI 

7. ขั้นตอนการดิจิไทซ์พื้นที่แปลง ที่มีการเพาะปลูกข้าวโพดเลี้ยงสัตว์ 

8. วิเคราะห์ค่าดัชนีพืชพรรณ NDVI และค่าดัชนีสิ่งปลกูสร้าง NDBI  

9. เปรียบเทียบค่าดัชนพีืชพรรณ NDVI และค่าดัชนีสิ่งปลูกสร้าง NDBI ว่ามีความสัมพันธ์กันหรือไม ่
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3.5 ขั้นตอนการท างาน 

 3.5.1 ขั้นตอนการดาวน์โหลดภาพถ่ายดาวเทียม 

 - เข้าเว็บ https://earthexplorer.usgs.gov/ จะปรากฏดังภาพให้คลิกที่  addressplace  

พิมพ ์  พื้นทีท่ีต่้องการ คลิกที่ Show 

 

ภาพที่ 3.1 วิธกีารดาวน์โหลดภาพดาวเทียม 

 

- ขั้นตอนต่อไปเลือกพื้นที่ศึกษา Address/Place > จังหวัดล าปาง จากนั้นคลิก Show 

 

ภาพที่ 3.2 เลอืกต าแหน่งภาพของพื้นที่ศกึษา 
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- ต าแหน่งพื้นที่ศึกษา อ าเภอแม่พริก จังหวดัล าปาง 

 

 

 

 

 

 

 

ภาพที่ 3.3 ต าแหน่งพื้นที่ศึกษา  

 

- ใส่ ว/ด/ป ที่เราต้องการดาวน์โหลดภาพใสช่อง Data Rage คลิกที่ Data Sets 

 

ภาพที่ 3.4 ก าหนดวันเดือนปีที่ต้องการดาวน์โหลด 
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- เลือกที่ Sentinel > Sentinel-2 > Additional Criteria 

 

 

 

 

 

 

 

 

 

ภาพที่ 3.5 เลอืกดาวเทียม Sentinel-2  

- เลือก Cloud Cover > Less than 10% > Results 

 

ภาพที่ 3.6 เลอืกเปอร์เซ็นตข์องเมฆน้อยที่สุด 
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- เลือกภาพตามที่เราต้องการดาวน์โหลด คลกิที่ Download Options > Download L1C Tile 

in JPEG2000 format (777.32 MiB) 

 

 

 

 

 

 

 

 

ภาพที่ 3.7 ดาวน์โหลดภาพดาวเทียม Sentinel-2  

 

- ท าการ Extract files คลิกขวาที่ไฟล์รูปเลือก  Extract to…….. 

 

 

ภาพที่ 3.8 แยก files ภาพ 
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3.5.2 ขั้นตอนการรวมแบนด์(Composite Band) 

 - เปิดโปรแกรม Erdas Imagine 2014 

 

ภาพที่ 3.9 โปรแกรม ERDAS IMAGINE 2014 

 

- คลิก Spectral เลือก Layer Stack 

- คลิกเลือกภาพถ่ายดาวเทียมแต่ละแบนด์เขา้มา > OK 

 

ภาพที่ 3.10 น าภาพดาวเทยีม Sentinel-2 เข้าโปรแกรม 

 

- น าภาพที่รวมแบนด์เข้ามา คลิก Open (Ctrl+O) > เลือกไปยังที่เก็บรูป > OK 

 

 

 

 

 

 

 

 ภาพที่ 3.11 ภาพที่รวมแบนด์เขา้มา 
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 3.5.3 ขั้นตอนการตัดขอบเขตพื้นที่ศึกษา 

 - เปิดภาพถ่ายดาวเทียมที่ได้ท าการรวมแบนด์ไว้แล้ว 

 

ภาพที่ 3.12 ภาพรวมแบนด ์

 

- น าไฟล์ขอบเขตพ้ืนที่เข้ามา > OK 

  

ภาพที่ 3.13 files ขอบเขตอ าเภอแม่พริก 
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- เลือกที่เครื่องมือ Vector > Paste from Selected Object 

- คลิกที่ไฟล์ Aoi002820 (:Aoi) > คลิกที่ขอบเขตดังรูป 

 

 

 

 

 

 

 

 

ภาพที่ 3.14 เครื่องมือตัดขอบเขต 

   

- เลือกที่เครื่องมือ Raster > Subset & Chip > Create Subset Image 

 

  ภาพที่ 3.15 ตัดขอบเขตอ าเภอแม่พริกของภาพดาวน์เทียมที่รวมแบนด์แล้ว 
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- เลือกที่เก็บ > AOI ให้เลือกเป็น Viewer > OK > OK 

  

ภาพที่ 3.16 เลือกที ่Save ภาพที่ตัดขอบเขต  

  

- รอโปรแกรมประมวลผลจนเสร็จ > Clise 

 

ภาพที่ 3.17 รอการประมวลผลของโปรแกรม 
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- จะได้ภาพขอบเขตพื้นที่ศึกษา ดังรูป 

 

ภาพที่ 3.18 ขอบเขตอ าเภอแม่พริกที่ท าการรวมแบนด์แล้ว 

 

 

3.5.4 น าข้อมลูพื้นที่ ที่มีการเพาะปลูกข้าวโพดเลี้ยงสัตว์แสดงเป็นจุดต าแหน่งแปลง 

(Point) 

 

- เปิดโปรแกรม Microsoft Excel 2016 

 

ภาพที่ 3.19 โปรแกรม Microsoft Excel 2016 
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- น าข้อมูลพื้นที่เพาะปลูกข้าวโพดเลี้ยงสัตว์ของเกษตรกรอ าเภอแม่พริก จังหวัดล าปาง              

ให้น าพิกัดแต่ละแปลงแยกเป็น X,Y ดังรูป 

 

ภาพที่ 3.20 ต าแหน่งการเพาะปลูกข้าวโพดเลี้ยงสัตว์ของอ าเภอแม่พริก 

 

- เปิดโปรแกรม Arc Map 10.4.1 

 

 

ภาพที่ 3.21 โปรแกรม Arc Map 10.4.1 
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- คลิกที่ File > Add Data > Add XY Data… 

- คลิกที่ ไฟล์ Exel ที่ได้ Save > Add > OK 

 

 

 

 

 

 

ภาพที่ 3.22 น าพิกัดในโปรแกรม Excel เข้า Arc Map 

 

3.5.5 น าภาพถ่ายดาวเทียมมา Mosaic เพื่อที่จะให้ภาพถา่ยดาวเทียมต่อกัน *กรณีที่

ภาพถ่ายดาวเทียมไม่ครอบคลุมพืน้ที่ศึกษา 

 

 -    คลิกที่ Raster > Mosaic > MosaicPro 

          -    คลิกที่เครื่องมือ Display Add Images Dialog 

 

    

 

 

 

 

ภาพที่ 3.23 การ MosaicPro ท าให้ภาพต่อกัน 
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- เลือกภาพดาวเทียมที่ได้ท าการรวมแบนด์แลว้ > OK 

- คลิกเครื่องหมายถูกที่ช่อง Vis 

- คลิกที่เครื่องมอื Dispay raster images 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 3.24 การน าภาพเข้า 
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- คลิกที่เครื่องมอื Process > Run Mosaic  

  

ภาพที่ 3.25 เครื่องมือการต่อภาพ  

 

- เลือกที่บันทึก > Save 

 

ภาพที่ 3.26 เลือกพื้นที่ Save 
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3.5.6 ขั้นตอนการท าภาพเปน็ NDVI และ NDBI 

-    คลิก Raster > Unsupervised > NDVI 

          -    ตั้งชื่อ Output แล้วเลือกช่อง Index ให้เป็น NDVI เลือกแบนด์ที่ใชใ้นการท าภาพ NDVI ดังภาพ 

แล้วคลิก OK 

 

 

 

 

 

 

 

 

  

ภาพที่ 3.27 ขั้นตอนการท าภาพ NDVI 

 

- รอโปรแกรมท าการประมวลผล 

 

ภาพที่ 3.28 รอการประมวลผลจากโปรแกรม 
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ภาพที่ 3.29 ภาพ NDVI 

 

3.5.7 ขัน้ตอนการท าภาพ NDBI 

 -    เปิดภาพที่ได้ท าการรวมแบนด์ขึ้นมา > คลิก Raster > Unsupervised > NDVI  

          -    เลอืกที่ Output File ให้เลือกที่ save > Index ให้เลือกเป็น NDBI > AOI ให้เลือก   Viewer > 

OK > OK 

 

 

 

 

 

 

 

 

 

ภาพที่ 3.30 ขั้นตอนการท าภาพ NDBI 
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- รอโปรแกรมท าการประมวลผล 

   

  ภาพที่ 3.31 รอการประมวลผลจากโปรแกรม   

   

  

 

ภาพที่ 3.32 ภาพ NDBI 

 

 

 

 

 



36 
 
 5.3.8 ขั้นตอนการดิจิไทซ์พื้นที่แปลง ที่มีการเพาะปลูกข้าวโพดเลี้ยงสัตว ์

 -    น าภาพถ่ายที่เป็น NDVI เข้ามา เพื่อดิจิไทซ์แปลงข้าวโพด 

 

ภาพที่ 3.33 เปิดภาพ NDVI  

 

- คลิกที่เครื่องมอื Drawing > Polygon 

- เลือกไฟล์ point เข้ามา 

- จากนั้นให้ท าการการดิจิไทซ์แปลงช่วงเวลาที่มีการเริ่มเพาะปลูก 

 

 

 

 

 

 

 

   

 

ภาพที่ 3.34 ขั้นตอนการดจิิไทซ ์
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3.5.9 ขั้นตอนการวิเคราะหค์่าดัชนีพืชพรรณ NDVI และค่าดชันีสิ่งปลูกสรา้ง NDBI 

 -    เปิดภาพที่เป็น NDVI ขึ้นมา 

          -    คลิกที่เครื่องมือ Raster > Supervised > Signature Editor 

 

 

    

 

 

 

 

ภาพที่ 3.35 การประมวลผล NDVI 

 

- ให้คลิกที่จุด ทีไ่ด้ท าการดิจิไทซ์ไว้ แล้วไปที่เครื่องมือ Create New Signature (s) From AOI 

- Add จุดที่เราได้ท าการดิจิไทซ์แปลงเพาะปลูกข้าวโพดเข้าให้ครบทุกจุด 

 

   

 

 

ภาพที่ 3.36 การรวมจุดแปลงเพาะปลูกข้าวโพด 
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- เลือกทุกจุด แล้วไปที่เครื่องมือ Merge Selected Signature เพื่อรวมให้เป็นจุดเดียวกัน 

- ให้ Delete Selection 1-6 ออก แล้วคลกิทีเ่ครื่องมือ Display Statistics Window 

- จะได้ค่าทางสถิติของ NDVI ดังรูป  

- ให้ท าแบบนี้จนครบ 3 ช่วงเวลาที่ได้ก าหนดไว้ ท าทั้งของ NDVI และ NDBI 

 

 

 

 

 

    

   

 

 

 

 

 

 

 

 

 

 

ภาพที่ 3.37 ขั้นตอนการหาค่า NDVI จากโปรแกรม ERDAS 
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- ข้อมูลภาพของ NDVI ช่วงระยะการเริ่มเพาะปลูกข้าวโพดเลี้ยงสัตว์ 

 

ภาพที่ 3.38 ค่า NDVI ของโปรแกรมในช่วงเพาะปลูก 

 

- ข้อมูลภาพของ NDVI ช่วงระยะการเจริญเติบโตของข้าวโพดเลี้ยงสัตว์ 

 

ภาพที่ 3.39 ค่า NDVI ของโปรแกรมในช่วงการเจรญิเติบโต 
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- ข้อมูลภาพของ NDVI ช่วงระยะเก็บเกี่ยวของข้าวโพดเลี้ยงสัตว์  

  

ภาพที่ 3.40 ค่า NDVI ของโปรแกรมในช่วงเก็บเกี่ยว 

   

- ข้อมูลภาพของ NDBI ช่วงระยะการเพาะปลูกของข้าวโพดเลี้ยงสัตว์ 

 

ภาพที่ 3.41 ค่า NDBI ของโปรแกรมในช่วงเพาะปลูก 

 

   



41 
 

- ข้อมูลภาพของ NDBI ช่วงระยะการเจริญเติบโตของข้าวโพดเลี้ยงสัตว์ 

 

ภาพที่ 3.42 ค่า NDBI ของโปรแกรมในช่วงการเจริญเตบิโต 

 

 

- ข้อมูลภาพของ NDBI ช่วงระยะเก็บเกี่ยวของข้าวโพดเลี้ยงสัตว์ 

 

ภาพที่ 3.43 ค่า NDBI ของโปรแกรมในช่วงเก็บเกี่ยว 
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บทที่ 4 

ผลการวิจัย 

 การศึกษาการใช้เทคนิค NDVI กับ NDBI ในการติดตามการเจริญเติบโตของข้าวโพดเลี้ยงสัตว์

กรณีศึกษา อ าเภอแม่พริก จังหวัดล าปาง ผู้วิจัยได้ก าหนดแบ่งผลการวิเคราะห์ออกเป็น 2 รูปแบบ คือ     1.

การประยุกต์ใช้เทคนิค NDVI กับ NDBI ในการติดตามการปลูกข้าวโพดเลี้ยงสัตว์ ในปี พ.ศ.2562 ของอ าเภอ

แม่พริก จังหวัดล าปาง 2.เปรียบเทียบค่าประสิทธิภาพ (NDVI,NDBI) โดยวิเคราะห์ด้วยการทดสอบทางสถิติ T-

Test ของข้าวโพดเลี้ยงสัตว ์

4.1 การประยุกต์ใช้เทคนคิ NDVI กับ NDBI ในการติดตามการปลูกข้าวโพดเลี้ยงสัตว์ ในปี พ.ศ.2562 ของ

อ าเภอแม่พริก จังหวัดล าปาง 

 

ตารางที่ 4.1 แสดงค่าทางสถิติของ NDVI ในการใช้ประโยชน์ที่ดิน ช่วงเริ่มเพาะปลูก ทั้งหมด 4 ประเภท 

 

ตารางที่ 4.2 แสดงค่าทางสถิติของ NDBI ในการใช้ประโยชน์ที่ดิน ช่วงเริ่มเพาะปลกู ทั้งหมด 4 ประเภท 
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ตารางที่ 4.3 แสดงค่าทางสถิติของ NDVI ในการใช้ประโยชน์ที่ดิน ช่วงเจรญิเติบโต ทั้งหมด 4 ประเภท 

 

 

ตารางที่ 4.4 แสดงค่าทางสถิติของ NDBI ในการใช้ประโยชน์ที่ดิน ช่วงเจรญิเติบโต ทั้งหมด 4 ประเภท 

 

 

ตารางที่ 4.5 แสดงค่าทางสถิติของ NDVI ในการใช้ประโยชน์ที่ดิน ช่วงเกบ็เกี่ยว ทั้งหมด 4 ประเภท 
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ตารางที่ 4.6 แสดงค่าทางสถิติของ NDBI ในการใช้ประโยชน์ที่ดิน ช่วงเก็บเกี่ยว ทั้งหมด 4 ประเภท 

 

 

4.2 เปรียบเทียบค่าประสิทธิภาพ (NDVI,NDBI) โดยวิเคราะห์ด้วยการทดสอบทางสถติิ T-Test ของ

ข้าวโพดเลี้ยงสัตว ์

ศึกษาการจ าแนกพื้นที่ปลูกข้าวโพดเลี้ยงสัตว์ โดยได้จากการวิเคราะห์ค่าการสะท้อนแสงของ 

ดัชนีความแตกต่างพืชพรรณ (NDVI) และค่าการสะท้อนแสงของค่าดัชนีสิ่งปลูก (NDBI) ของ

ข้อมูลภาพถ่ายดาวเทียม 3 ช่วงเวลา คือ ช่วงเพาะปลูก ช่วงเจริญเติบโต และช่วงเก็บเกี่ยว ระหว่างปี 

พ.ศ.2562 และปี พ.ศ.2563 

1. ทดสอบสมมุติฐานว่าค่า NDVI,NDBI ของพื้นที่เพาะปลูกข้าวโพดเลี้ยงสัตว์แตกต่างจากพื้นที่การ

ใช้ประโยชน์ที่ดินชนิดอื่นหรือไม่ ที่ระดับความเช่ือมั่น 95% 

สมมุติฐานทางการวิจัย 

- สมมุติฐานหลัก : พื้นที่เพาะปลูกข้าวโพดเลี้ยงสัตว์กับพืน้ที่การใช้ประโยชน์ชนิดอื่น  

ไม่แตกต่างกัน 

- สมมุติฐานรอง : พื้นที่เพาะปลูกข้าวโพดเลี้ยงสัตว์กับพืน้ที่การใช้ประโยชน์ชนิดอื่น แตกต่างกัน 
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ตารางที่ 4.7  แสดงผลการวิเคราะห์ ค่าทางสถิติช่วงเริ่มเพาะปลูก ของข้าวโพดเลี้ยงสัตว์เมื่อเทียบกับ การใช้

ประโยชน์ที่ดินชนิดอื่น ในสมมุติฐานที่ 2 

 

 

สรุปผลการทดสอบโดยโปรแกรม 

 ผลการวิเคราะห์ ค่า NDVI และ NDBI ของข้าวโพดเลี้ยงสัตว์เมื่อเทียบกับ ใช้ประโยชน์ที่ดินชนิดอื่นๆพบว่าค่า 

P(T<=t) two-tail มีค่าเท่ากับ 0.42 ซึ่งมากกว่าค่าระดับนัยส าคัญ 0.05 จึง ปฏิเสธ H1 ยอมรับ H0 นั่น

หมายความว่า NDVI และ NDBI ของข้าวโพดเลี้ยงสัตว์ไม่แตกต่างจากพืชอื่นอย่างมีนัยส าคัญทางสถิต ิ

 

ตารางที่ 4.8  แสดงผลการวิเคราะห์ ค่าทางสถิติช่วงเจริญเติบโต ของข้าวโพดเลี้ยงสัตว์เมื่อเทียบกับ การใช้

ประโยชน์ที่ดินชนิดอื่น ในสมมุติฐานที่ 2 
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สรุปผลการทดสอบโดยโปรแกรม 

 ผลการวิเคราะห์ ค่า NDVI และ NDBI ของข้าวโพดเลี้ยงสัตว์เมื่อเทียบกับ ใช้ประโยชน์ที่ดินชนิดอื่นๆพบว่าค่า 

P(T<=t) two-tail มีค่าเท่ากับ 0.31 ซึ่งมากกว่าค่าระดับนัยส าคัญ 0.05 จึง ปฏิเสธ H1 ยอมรับ H0 นั่น

หมายความว่า NDVI และ NDBI ของข้าวโพดเลี้ยงสัตว์ไม่แตกต่างจากพืชอื่นอย่างมีนัยส าคัญทางสถิต ิ

ตารางที่ 4.9  แสดงผลการวิเคราะห์ ค่าทางสถิติช่วงเก็บเกี่ยว ของข้าวโพดเลี้ยงสัตว์เมื่อเทียบกับ การใช้

ประโยชน์ที่ดินชนิดอื่น ในสมมุติฐานที่ 2 

 

 

สรุปผลการทดสอบโดยโปรแกรม 

 ผลการวิเคราะห์ ค่า NDVI และ NDBI ของข้าวโพดเลี้ยงสัตว์เมื่อเทียบกับ ใช้ประโยชน์ที่ดินชนิดอื่นๆพบว่าค่า 

P(T<=t) two-tail มีค่าเท่ากับ 0.61 ซึ่งมากกว่าค่าระดับนัยส าคัญ 0.05 จึง ปฏิเสธ H1 ยอมรับ H0 นั่น

หมายความว่า NDVI และ NDBI ของข้าวโพดเลี้ยงสัตว์ไม่แตกต่างจากพืชอื่นอย่างมีนัยส าคัญทางสถิติ 
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บทที่ 5 

สรุปผลการศึกษาและข้อเสนอแนะ 

5.1 สรุปผลการวิจัย 

วัตถุประสงค์ข้อที่ 1. การประยุกต์ใช้เทคนิค NDVI กับ NDBI ในการติดตามการปลูกข้าวโพดเลี้ยงสัตว์ ใน

ปี พ.ศ.2562 ของอ าเภอแม่พริก จังหวัดล าปาง 

 การประยุกต์ใช้ข้อมูลดาวเทียม Sentinel-2 ศึกษาพื้นที่เกษตรกรข้าวโพดเลี้ยงสัตว์ปีเพาะปลูก 2562 

ในเขตอ าเภอแม่พริก จังหวัดล าปางด้วยเทคนิค NDVI และ NDBI ดาวเทียม Sentinel-2 มีเครื่องตรวจวัดที่

เรียก Multispectral Instrument : MSI ประกอบไปด้วย 12 Band 

การวิเคาะห์ NDVI และ NDBI ของดาวเทียม Sentinel-2 

 NDVI           = (NIR-Red)/(NIR+Red)  

Sentinel-2 :(Band8-Band4)/ (Band8+Band4) 

NDBI           = (R1650-R830)/(R1650+R830) 

Sentinel-2 :(Band11-Band8)/ (Band11+Band8) 

ผลการวิเคราะห์การจ าแนกพื้นที่จากดัชนีความแตกต่างพืชพรรณ (NDVI) และดัชนีความ แตกต่าง

ของสิ่งปลูกสร้าง (NDBI) ที่ได้ เมื่อน าค่าที่ได้จากโปรแกรมมาวิเคราะห์จึงเห็นได้ว่ามีความแตกต่างจากการใช้

ประโยชน์ที่ดิน ชนิดอื่น ได้แก่ ข้าวโพดเลี้ยงสัตว์,พื้นที่แหล่งน้ า,พื้นที่ป่า,พื้นที่หมูบ้าน ในช่วงเวลา (เพาะปลูก, 

เจริญเติบโต และเก็บเกี่ยว) สรุปได้ว่าดัชนีความแตกต่างพืชพรรณ (NDVI) ปีพ.ศ. 2562-2563 และดัชนีความ

แตกต่างของสิ่งปลูกสร้าง (NDBI) ปีพ.ศ.2562-2563 ทุกประเภทมีความแตกต่างกันเล็กน้อยของทุกช่วงเวลา  

วัตถุประสงค์ข้อที่ 2. เปรียบเทียบค่าประสิทธิภาพ (NDVI,NDBI) โดยวิเคราะห์ด้วยการทดสอบทางสถิติ 

T-Test ของข้าวโพดเลี้ยงสัตว์ 

 จากสมมติฐานข้อที่2 ผลการวิเคราะห์การจ าแนกพื้นที่เพาะปลูกข้าวโพดเลี้ยงสัตว์เปรียบเทียบกับ 

พื้นที่การใช้ประโยชน์ที่ดินอ่ืนๆ ได้แก่ ข้าวโพดเลี้ยงสัตว์,พืน้ที่แหล่งน้ า,พื้นที่ป่า,พืน้ที่หมูบ้าน ด้วยดัชนีพืช

พรรณ NDVI และ NDBI เมื่อน าพื้นเพาะปลูกข้าวโพดเลี้ยงสัตว์มาเปรียบเทียบกับการใช้ประโยชน์ที่ดินชนิดอ่ืน

โดยใช้การวิเคราะห์สมมติฐาน T-Test ผลการวิเคราะห์ค่า NDVI และ NDBI ของพ้ืนที่เพาะปลูกเมื่อเปรียบกับ

การใช้ประโยชน์ที่ดินชนิดอ่ืนพบว่าค่า P(T<=t) two-tail มีค่ามากกว่าค่าระดับนัยส าคัญ 0.05 จึงยอมรับ H0 
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ปฏิเสธ H1คือค่า NDVI และ NDBI ของพ้ืนที่เพาะปลูกข้าวโพดเลี้ยงสัตว์ไม่แตกต่างจากพื้นที่การใช้ประโยชน์

ที่ดินชนิดอ่ืนอย่างมีนัยส าคัญทางสถิติที่ระดับความเช่ือมั่น 95% 

  สรุปได้ว่าพื้นที่เพาะปลูกข้าวโพดเลี้ยงสัตว์อ าเภอแม่พริก จังหวัดล าปาง ไม่แตกต่างจาก พื้นที่การใช้

ประโยชน์ที่ดินชนิดอื่น อย่างชัดเจน 

 

5.2 ข้อเสนอแนะ 

1. การใช้ภาพถ่ายดาวเทียมควรค านึงถึงช่วงเวลาที่อาจมีเมฆปกคลุมบนภาพถ่าย ถ้าหลีกเลี่ยงไม่ได้

ควรหาภาพดาวเทียมอื่นหรือศึกษาวิธีการอื่นๆ 

2. ควรน าเทคนิค NDVI ขั้นสูงชนิดอื่นมาประยุกต์ เพื่อเพิ่มความถูกต้องในการจ าแนกพื้นที ่

3. การศึกษาศักยภาพการผลิตข้าวโพดเลี้ยงสัตว์ในครั้งนี้ไม่ได้มีการลงพ้ืนที่เก็บข้อมูลผลผลิต 

ต่อไร่ของเกษตรกร ควรมีการเก็บข้อมูลผลผลิตข้าวโพดเลี้ยงสัตว์จากเกษตรกรโดยตรง 
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